NAVIGATION TRAINING MATERIALS REV 1

The Navigation Training Materials as previously issued are included. It is intended to be used as an aid to educate you about the terminology used in the Banner 2000 modules and how to navigate through the system.

Navigation Training may also be taught to **Banner Users** through a tutorial. Banner Users may access using Windows Explorer to get to your Q:drive.

- Windows Explorer
- Click (Q:)
- Click on the folder “Banner”
- Click on “Nav5demo”

The tutorial runs approximately 30 minutes. It is self-explanatory.
Canisius College
NAVIGATION TRAINING OUTLINE

A) Main Screen Look

1) Menu bar top/left
2) Tool bar Icons (pictures)
3) Direct Access/Title bar at the top of form
4) Auto Hint/Status Line at bottom of screen

B) Naming Process of Forms

1) FOIDOCH – F = Finance, O = Operations, I = Inquiry, DOCH = document history form
2) FOAIDEN – F = Finance, O = Operations, A = Application, IDEN = Identification form

C) Forms Types

1) Applications
2) Maintenance
3) Query
4) Inquiry
5) Report or submission

D) Form Elements

1) Searchlights
2) Blue Typeface
3) Drop down menus
4) Check boxes
5) Response buttons (yes, no, cancel, etc.)
6) Scroll bars

E) Miscellaneous Keystrokes

1) Tab Key
2) Arrow down/up
3) Control Page down/Page up
4) F7/F8
5) F6/F4
6) F10
# QUICK REFERENCE GUIDE

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>TOOLBAR</th>
<th>PULL DOWN</th>
<th>KEYBOARD</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAVE</td>
<td></td>
<td>FILE SAVE</td>
<td>F10</td>
</tr>
<tr>
<td>ROLLBACK</td>
<td></td>
<td>FILE ROLLBACK</td>
<td>SHIFT &amp; F7</td>
</tr>
<tr>
<td>SELECT</td>
<td></td>
<td>FILE SELECT</td>
<td>SHIFT &amp; F3</td>
</tr>
<tr>
<td>INSERT RECORD</td>
<td></td>
<td>RECORD INSERT</td>
<td>F6</td>
</tr>
<tr>
<td>DELETE RECORD</td>
<td></td>
<td>RECORD REMOVE</td>
<td>SHIFT &amp; F6</td>
</tr>
<tr>
<td>QUERY ENTER</td>
<td></td>
<td>QUERY ENTER</td>
<td>F7</td>
</tr>
<tr>
<td>QUERY EXECUTE</td>
<td></td>
<td>QUERY EXECUTE</td>
<td>F8</td>
</tr>
<tr>
<td>QUERY CANCEL</td>
<td></td>
<td>QUERY CANCEL</td>
<td>ESC</td>
</tr>
<tr>
<td>RECORD NEXT</td>
<td></td>
<td>RECORD NEXT</td>
<td>DOWN ARROW</td>
</tr>
<tr>
<td>RECORD PREVIOUS</td>
<td></td>
<td>RECORD PREVIOUS</td>
<td>UP ARROW</td>
</tr>
<tr>
<td>BLOCK PREVIOUS</td>
<td></td>
<td>BLOCK PREVIOUS</td>
<td>CTRL &amp; PAGEUP</td>
</tr>
<tr>
<td>NEXT BLOCK</td>
<td></td>
<td>BLOCK</td>
<td>CTRL &amp; PAGEDOWN</td>
</tr>
<tr>
<td>SEND/VIEW MESSAGES</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRINT</td>
<td></td>
<td>FILE PRINT</td>
<td>ATL &amp; PRINT SCREEN</td>
</tr>
<tr>
<td>SHOW KEYS</td>
<td></td>
<td>HELP SHOW KEYS</td>
<td>CTRL &amp; F1</td>
</tr>
<tr>
<td>EXIT</td>
<td></td>
<td>FILE EXIT</td>
<td>CTRL &amp; Q</td>
</tr>
<tr>
<td>SEARCH</td>
<td></td>
<td></td>
<td>F9</td>
</tr>
</tbody>
</table>
# Naming Conventions

Banner2000 forms, reports, jobs, and tables have seven-character names with the following structure:

<table>
<thead>
<tr>
<th>Position 1</th>
<th>A Alumni/Development</th>
<th>L Occupational Tax/License</th>
<th>U Utilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>B Property Tax</td>
<td>N Position Control</td>
<td>O Customer Contact</td>
<td>V Voice Response</td>
</tr>
<tr>
<td>C Courts</td>
<td>P HR/Payroll/Personnel</td>
<td>Q Electronic Work Queue</td>
<td>X Records Indexing</td>
</tr>
<tr>
<td>D Cash Drawer</td>
<td>R Financial Aid</td>
<td>S Student</td>
<td>W Reserved for client</td>
</tr>
<tr>
<td>F Finance</td>
<td>T Accounts Receivable</td>
<td>Y applications that co-exist</td>
<td>Z with Banner2000</td>
</tr>
<tr>
<td>G General</td>
<td>I Information Access</td>
<td>K Work Management</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Position 2</th>
<th>E Event Management</th>
<th>F Finance Accounts Receivable</th>
<th>G General Accounts Receivable</th>
</tr>
</thead>
<tbody>
<tr>
<td>J Job Submission</td>
<td>H Grades/Academic History</td>
<td>I Validation form/table</td>
<td>K Reserved for SCT Intl-UK</td>
</tr>
<tr>
<td>L Letter Generation</td>
<td>J Investment Management</td>
<td>U Utility</td>
<td>L Location Management</td>
</tr>
<tr>
<td>O Overall</td>
<td>T Validation form/table</td>
<td>U Utility</td>
<td>U Utility</td>
</tr>
<tr>
<td>P Purge</td>
<td>T Validation form/table</td>
<td>U Utility</td>
<td>L Location Management</td>
</tr>
<tr>
<td>S Security</td>
<td>M CAPP</td>
<td>R Research Accounting</td>
<td></td>
</tr>
<tr>
<td>T Validation form/table</td>
<td>O Overall</td>
<td>S Stores Inventory</td>
<td></td>
</tr>
<tr>
<td>U Utility</td>
<td>P Person</td>
<td>T Validation form/table</td>
<td></td>
</tr>
<tr>
<td>X Cross Product</td>
<td>R Recruiting</td>
<td>U Utility</td>
<td></td>
</tr>
<tr>
<td>Accounts Receivable (T)</td>
<td>S Schedule</td>
<td>X Archive/Purge</td>
<td></td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>T Validation form/table</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Financial Aid (R)</th>
<th>HR/Payroll/Personnel (P)</th>
<th>Position Control (N)</th>
<th>Alumni/Development (A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>B Budgeting</td>
<td>A Application</td>
<td>A Accounts Payable</td>
<td></td>
</tr>
<tr>
<td>C Record Creation</td>
<td>B Budget</td>
<td>B Budget Development</td>
<td></td>
</tr>
<tr>
<td>E Electronic Data Exchange</td>
<td>C COBRA</td>
<td>C Cost Accounting</td>
<td></td>
</tr>
<tr>
<td>F Funds Management</td>
<td>D Benefit/Deductions</td>
<td>D Campaign</td>
<td></td>
</tr>
<tr>
<td>H History and Transcripts</td>
<td>E Employee</td>
<td>E Event Management</td>
<td></td>
</tr>
<tr>
<td>J Student Employment</td>
<td>H Time Reporting/History</td>
<td>G Pledge and Gift/Pledge Payment</td>
<td></td>
</tr>
<tr>
<td>L Logging</td>
<td>O Overall</td>
<td>M Prospect Management</td>
<td></td>
</tr>
<tr>
<td>N Need Analysis</td>
<td>P General Person</td>
<td>A Membership</td>
<td></td>
</tr>
<tr>
<td>O Common Functions</td>
<td>R Electronic Approvals</td>
<td>D Designation</td>
<td></td>
</tr>
<tr>
<td>P Packaging &amp; Disbursements</td>
<td>S Security</td>
<td>E Event Management</td>
<td></td>
</tr>
<tr>
<td>R Requirements Tracking</td>
<td>T Validation rule table</td>
<td>F Campaign</td>
<td></td>
</tr>
<tr>
<td>S Student System Shared Data</td>
<td>U Utility</td>
<td>G Pledge and Gift/Pledge Payment</td>
<td></td>
</tr>
<tr>
<td>T Validation form/table</td>
<td>X Tax Administration</td>
<td>X Expected Matching Gift</td>
<td></td>
</tr>
<tr>
<td>U Utility</td>
<td>Information Access (T)</td>
<td>S Student</td>
<td></td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>R Financial Aid</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

All Products

- W Reserved for client forms or modules used within a Banner2000 application (character in position 1)
- Y does not equal W, Y, or Z
Position 3 identifies the type of form, report, job, or table.

<table>
<thead>
<tr>
<th>General (G)</th>
<th>Student (S)</th>
<th>Finance (F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Application form</td>
<td>A Application form</td>
<td>A Application form</td>
</tr>
<tr>
<td>B Base table</td>
<td>B Base table</td>
<td>B Base table</td>
</tr>
<tr>
<td>I Inquiry form</td>
<td>I Inquiry form</td>
<td>I Inquiry form</td>
</tr>
<tr>
<td>O Online COBOL process</td>
<td>P Process</td>
<td>M Maintenance form</td>
</tr>
<tr>
<td>Q Query form</td>
<td>Q Query form</td>
<td>Q Query form</td>
</tr>
<tr>
<td>R Rule table</td>
<td>R Rule table</td>
<td>R Rule table</td>
</tr>
<tr>
<td>T General maintenance</td>
<td>V Validation form/table</td>
<td>V Validation form/table</td>
</tr>
<tr>
<td>V Validation form/table View</td>
<td>V Validation form/table View</td>
<td>V Validation form/table View</td>
</tr>
</tbody>
</table>

Accounts Receivable (T)

<table>
<thead>
<tr>
<th>Financial Aid (R)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Application form</td>
</tr>
<tr>
<td>B Base table</td>
</tr>
<tr>
<td>I Inquiry form</td>
</tr>
<tr>
<td>P Process/report</td>
</tr>
<tr>
<td>R Rule table</td>
</tr>
<tr>
<td>T Temporary table</td>
</tr>
<tr>
<td>V Validation form/table View</td>
</tr>
</tbody>
</table>

Position Control (N)

<table>
<thead>
<tr>
<th>Alumni/Development (A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Application form</td>
</tr>
<tr>
<td>B Base table</td>
</tr>
<tr>
<td>I Inquiry form</td>
</tr>
<tr>
<td>P Process</td>
</tr>
<tr>
<td>R Rule table</td>
</tr>
<tr>
<td>T Temporary table</td>
</tr>
<tr>
<td>V Validation form/table View</td>
</tr>
</tbody>
</table>

Examples:

<table>
<thead>
<tr>
<th>SPAIDEN</th>
<th>SHROLL</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>S</td>
</tr>
<tr>
<td>P</td>
<td>H</td>
</tr>
<tr>
<td>A</td>
<td>R</td>
</tr>
<tr>
<td>IDEN</td>
<td>ROLL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STVSTAT</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
</tr>
<tr>
<td>T</td>
</tr>
<tr>
<td>V</td>
</tr>
<tr>
<td>STAT</td>
</tr>
</tbody>
</table>
Banner2000 Navigation Training Guide
The guide is intended to be used an aid to educate yourself about the terminology used in
the Banner2000 modules and how to navigate through the system.

Logon Procedures:
First you will have to logon to the network. At the Novell Client for Windows 95
screen enter your username and password. This is the screen you normally see on
your desktop each day when you logon to the server.

![Novell Login](image)

To enter the Banner2000 system:
Double click the Banner icon on the desktop.

![Banner Icon](image)

From the logon screen:

![Logon](image)

Enter a username TRAIN{xx} (replacing the xx with the number in the
upper right hand corner of your monitor). The password for all TRAIN accounts
is BANNER. The database name is TRNG. When all three fields have been
entered, click the CONNECT button.

NOTE: Case is not an issue in the entry of any of these fields.
Components of the Banner Main Menu

Menu Bar
Contains pull-down menu options, providing a variety of selections for navigating within Banner 2000.

Horizontal and Vertical Toolbar
A toolbar is a set of icons that represent shortcuts for performing common functions. The horizontal toolbar performs commonly used functions within the Banner system. The vertical toolbar generally contains icons of commonly used programs/software packages.

The Pull Down List displays the menu that is currently opened (and being displayed in greater detail in the right pane). Can Also use this to return to “previous” menus.

The Left Pane shows various levels of menus at your organization. Standard menus are delivered with Banner 2000.

The Direct Access field allows users who already know a form name, to access it without having to click through the menus.

The Right Pane shows the content of the menu that is open (selected from the left pane). As folders on the left panel are opened, the menus (and names of menus) become more detailed in the right pane. Eventually, the right pane will display form descriptions and names.

The Auto Hint/Status Line briefly describes the field where the cursor is located, the purpose of the field, what can be done next or how to move to the next window. Error messages and processing messages also appear here.
Folders

Closed folders indicate that the menu can be opened to show more menus or forms.

Open folders indicate that the menu has been opened.

You can click on menus in the right pane to display contents, or may click on folders in the left pane until forms show in the right pane.
Form Components

The navigation frame shows all your navigational options for the current block. Some options take you to other blocks and windows within the current form, Other options take you outside the current form to other related forms.

The Title bar show the form's descriptive name, the seven-character ID (form code name), the software version number, and the database name.

The Key block contains fields which require Key information needed by the system to "know" what data to retrieve and include in the rest of the form.

Block This is where information is added to update a record.

Iconic buttons are small squares that contain an icon (picture). They represent one or more actions that can be performed for the associated field or record. For example, you can use iconic buttons to display a validation form for the field, copy a record, and display a window for entering freeform text.

Pull-down lists are used to select a field value from a list of pre-defined values. A down arrow in the right side of the field indicates the field has a pull-down list.

Radio buttons are small circles used to select one of several options in a group. Each radio button represents a choice for the group. You can pick only one radio button in a group. When you select a radio button, the previously selected button is cleared and a smaller, filled circle fills the newly selected button.

Fields are areas on a form where you can enter, query, change, and display specific information.

Checkboxes are small boxes used to enable or disable features or options. When an option is enabled, a check mark appears in the checkbox. When the option is disabled, the checkbox is empty.
Searching for Records/Finding Values

Clicking on the Search icon will transfer you to a search screen that will allow you to enter criteria to help locate a record. In this instance, clicking on the Search icon will take you to the Person Search Form (SOAIDEN).

List of Values is available for those fields having field names displayed in a blue color. To see a list of values for the current field, simply double-click or choose the List option from the Help menu.
A search form will allow entry of various criteria to use in your search.

Wildcards allowed in these criteria are:

_  single character search  e.g.  W_ils will return all persons whose last name starts with a W, has any character as the second character, and then ends with ils.  I.e.  Walls, Wills

%  Multiple character search  e.g.  %ill will return all person records whose last name ends in ll

I.e.  Will, McCall, Hallwell

Once you have entered your search criteria, hit the F8 key or the Execute Query button on the toolbar to search for records that match your criteria.

To select one of the records returned, double click on the KEY field for that record (in this example – ID), or click on the Select button on the toolbar.

To enter another query, click on the Enter Query button on the toolbar.

For instances where more information may be needed to identify the correct record, the "Search and Display More Detail Option" is available. For example, when searching on a common name like Smith, you might want to display more detail than the current screen in order to identify the correct John Smith.

For searches where the name spelling is uncertain, the "Sounds Like" option will return records that sound like the criteria entered.
Navigating Through Forms

Navigating between blocks: Menubar or Next Block Icon (or can use mouse)
Navigating between fields: Use tab key or click on desired field
Saving changes to forms: Click Save button in toolbar & check Status Bar for results

If you wanted to cancel all the changes you've made, you would click the Rollback button.
Clicking Rollback AFTER saving changes to a record allows you to begin working on a new record using the same form.

The Exit button takes you back to the menu if you came to this form from a menu. If you came from another form, it takes you back to that form.
Menu Bar – File Menu

The File pull-down menu lists Banner2000 and Oracle functions. It also displays the last 10 forms a user has accessed. This example shows three (Note: Oracle is a relational database management system, a third-party product that Banner2000 uses).

Direct Access Displays the Direct Access Form (GUAPARM), which is used to access a form by its seven-character name.

Object Search Displays the Object Search Form (GUIOJECTS), which is used to search for a menu, form, job, or QuickFlow with part of the name, description, or type.

QuickFlow Displays the QuickFlow Form (GUAQFLOW), which is used to access a QuickFlow.

Select Returns you to the calling form and enters the selected value into the field that called the form.

Rollback Clears all information (except key information) and returns you to the first enterable field in the Key block.

Save Saves all changes entered since the last time you saved.

Refresh Clears the message line, redraws the screen.

Print Prints the current window with the date and time in the title bar.

Exit From a form, exits you from the form. From the main menu, exits you from Banner2000. From query mode, cancels the query.

Exit QuickFlow Exits you from a QuickFlow.

Preferences Displays the Personal Preferences Maintenance Form (GUAUPRF), which is used to customize Banner2000 for individuals.

(List of recently accessed forms) Lets you quickly re-access forms that were previously accessed in this session.
Menu Bar – Edit Menu

The Edit pull-down menu contains the functions used to edit text items, such as descriptions. Click each item on the list to learn more about it.

- **Cut** Cuts selected text and places it on the clipboard.
- **Copy** Copies selected text to the clipboard.
- **Paste** Pastes text from the clipboard to the spot where the cursor is located.
- **Edit** Displays the Editor window, which is used to enter or update text.
Menu Bar – Block Menu

The Block pull-down menu enables you to move from one area to another within a form. Click each item on the list to learn more about it.

Block - A collection of related information, usually inside a beveled box or within a window. It may contain records and fields. A form can consist of one block or many blocks.
Previous Moves the cursor to the previous block that has at least one enterable field.
Next Moves the cursor to the next block that has at least one enterable field.
Clear Clears all information from the current block.
Menu Bar – Field Menu

The Field pull-down menu enables you to move from one field to another within a form.

Field - An area on the form where you can enter, query, change, and display specific information.
Previous Moves the cursor to the previous enterable field.
Next Moves the cursor to the next enterable field.
Clear Clears all information from the current field on your display.
Duplicate In a blank row of a repeating record, duplicates the contents of the same field in the previous record and copies it into the new record.
Menu Bar – Record Menu

The Record pull-down menu lets you work with records within a form. A record is a group of fields that are interrelated. For example, an address is a record made of several fields: street, city, state, ZIP/postal code.

- **Previous** Moves the cursor to the first enterable field in the previous record.
- **Next** Moves the cursor to the first enterable field in the next record of the current block. If the cursor is in the last record, a new record is created.
- **Scroll Up** Scrolls up the list of repeating records, putting the first displayed record near the bottom of the list.
- **Scroll Down** Scrolls down the list of repeating records, putting the last displayed record near the top of the list.
- **Clear** Clears all information from the current record on your display.
- **Remove** Removes all information for the current record. When you Save, the removed information is deleted.
- **Insert** Inserts a new blank record into the list of existing records.
- **Duplicate** Duplicates contents of all fields in the record and copies them into a new one.
- **Lock** Temporarily locks the contents of the record so no other Banner2000 user can update it. Save, Rollback, and Exit release the lock.
Menu Bar – Query Menu

The Query pull-down menu lets you see what information is in the database that matches the specified criteria. Click each item on the list to learn more about it.

Enter Puts the form into query mode so you can enter search criteria to see what information is already in the database.

Execute Searches the database and displays records that match your search criteria.

Last Criteria Enters the criteria from your last search (enabled only when you are in query mode).

Cancel Cancels the query and takes the form out of query mode.

Count Hits Counts the number of records that match the search criteria and displays that number in the auto hint.

Fetch Next Set If more records meet the search criteria than fit in the window, replaces the current set of displayed records with the next set.
Toolbar Basics

Toolbars are a set of iconic buttons that represent shortcuts for performing functions. Toolbars may be customized by your institution.

The horizontal toolbar appears directly under the menu bar, and the vertical toolbar appears on the left side of the screen. When you move your cursor to an iconic button, a yellow bubble appears and describes the function of the button.

Many of the buttons found on the toolbars represent shortcuts for common functions found on the menu bar.
Online Help Process

- Place the cursor in an "enterable" field
- Click the Online Help button in the toolbar, or select Online Help from the Help pull-down menu on the Menu Bar. Field-level help appears

Additional Help Buttons Include:

- **Form Overview Button** - Displays an overview of the current form.
- **How Do I...? Button** - This button displays a list of procedures for using the current form. From this list, you can display a specific procedure.
- **Field List Button** - This button displays a list of all windows, blocks, and fields on the current form. From this list, you can click the icon or name of the window, block, or field to display details of the selected

**Displaying a Procedure for the Current Form:**
1. Access Online Help.
2. Click blue How Do I...? button at the top of any Online Help topic. A list shows all procedures for form.
3. Click button or name of procedure you want to display.
4. (Optional) To display field description for field referenced in a procedure, click underlined field name.
5. (Optional) If the procedure includes a sub-procedure (entire step is underlined), click the underlined step. The sub-procedure appears in a separate topic. To return to the main procedure, click the last step in the sub-procedure.

**Displaying Help for Another Form in Banner:**
1. Access Online Help.
2. Click the Contents folder tab at the top of the Online Help window. A Table of Contents appears.
3. Double-click a form name to expand the Table of Contents.
4. Double-click the topic you want to access. The selected topic appears. Use the blue buttons at the top of the topic to navigate through the form's Online Help.
This is the traditional help for Banner2000 forms, blocks, and fields. Banner2000 Dynamic Help is gradually being replaced by Online Help.

Banner2000 Dynamic Help

This help is delivered and updated each time the system is upgraded. You can change this help text, but each system upgrade overwrites your changes. This type of Dynamic Help is gradually being replaced by the Online Help.

Local Dynamic Help

This help is completely written and maintained by your organization. System upgrades do not affect this help text. This is the default when you access Dynamic Help.

Dynamic Help is displayed on the Help Form (GUAHELP), which has a Main Window, where you can identify the help text you want to access, and a Help Text Window that contains the actual help text.

You can access GUAHELP in query mode or edit mode:

In query mode, you can display and search for text. GUAHELP also shows the field description from the Data Element Dictionary (DED) for a database field.

In edit mode, you can display, search for, add, update, and replace text.

Access Dynamic Help in Query Mode

Press Shift and double-click any field, or select Dynamic Help Query from the Help pull-down menu on the Menu bar. The Help Form (GUAHELP) appears. The default selection criteria indicate Local Dynamic Help for the field you clicked.

Verify the default selection criteria. Change if necessary.

Click the Display button. The Help Text window shows help text for the requested item.

Access Dynamic Help in Edit Mode

Select Dynamic Help Edit from the Help pull-down menu on the Menu bar. The Help Form (GUAHELP) appears. The default selection criteria indicates Local Dynamic Help for the current field.

Verify the default selection criteria. Change if necessary.

Click the Edit button or select the Next Block function. The Help Text window shows help text for the requested item.

If you don't know the name of the block or field whose Dynamic Help you want to display Access the Help Form (GUAHELP).

Click the Banner2000 or Local radio button on the main window.

For block names, click the Search button on the Block field. An LOV appears.
This tool lets you access Banner2000 documents directly from your computer. These electronic documents look the same as the hard copy versions, regardless of the computer you are using.

Banner 2000 Bookshelf

This tool lets you access Banner2000 documents directly from your computer. These electronic documents appear in PDF (portable document format). They look the same as the hard copy versions, regardless of the computer you are using. You can also print any document locally.

The following documents can be accessed directly from your computer using the Banner2000 Bookshelf:

- User manuals
- Technical reference manual (TRM)
- Object:Access Reporting Data Models
- Release guides
- Upgrade guides
- Implementation guides
Help (Item Properties)

Help (Item Properties) lists all the properties of the field where the cursor is currently located. For example, you can find its internal database name, whether it is queryable, whether it is required, type of data (character or numeric), maximum length, and minimum and maximum values.
Other Help

Show Keys lists the Oracle functions and associated keystrokes available in your environment for the current field, window, and form. Specific keystrokes for a function depend on your environment.

The auto hint at the bottom of the form can contain the following information for the field where the cursor is located:

- Brief field description
- Error and processing messages
- Keyboard equivalents, if you can access other blocks, windows, or forms from the field
Menu Bar – Window Menu

The Window pull-down menu is a feature of Microsoft Windows. It is not a part of Banner2000, but is included for the convenience of Microsoft Windows users. Click each item on the pull-down list to learn more about it.

- **Cascade** Arranges each open window in a cascade.
- **Tile** Arranges each open window in a tiled format.
- **Arrange Icons** If an open window is collapsed into an icon, lets you move the icon.

**NOTE:** If a pull-down menu item is gray or dimmed, the menu item is disabled and cannot be accessed.
CANISIUS COLLEGE

BANNER FINANCE 4

DIRECT PAY REQUEST, GENERAL JOURNAL, AND VISA TRAINING MATERIAL REV 2

OFFICE OF THE CONTROLLER

SUMMER 2002
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ii</td>
<td>Table of Contents, Rev 1, July 2002</td>
</tr>
<tr>
<td>1</td>
<td>Installing and modifying Canisius College Templates for Windows 95/98</td>
</tr>
<tr>
<td>2</td>
<td>Direct Pay Request Policy and Procedure, Rev 1, July 2002</td>
</tr>
<tr>
<td>3</td>
<td>Direct Pay Request, Rev 2 March 2002 – Sample</td>
</tr>
<tr>
<td>4</td>
<td>Canisius College Employee Payroll Request REV 1 MARCH 2002</td>
</tr>
<tr>
<td>5</td>
<td>Request for Vendor ID Number REV 2 JULY 2002</td>
</tr>
<tr>
<td>6 - 7</td>
<td>Direct Pay Requests Instructions</td>
</tr>
<tr>
<td>8</td>
<td>Business Process Menu – Sample</td>
</tr>
<tr>
<td>9</td>
<td>Screen for FTIDEN – Sample</td>
</tr>
<tr>
<td>10– 16</td>
<td>Direct Pay Request Instructions with and without Social Security Number</td>
</tr>
<tr>
<td>16</td>
<td>How to Cancel a Direct Pay Request FAAINVD</td>
</tr>
<tr>
<td>16</td>
<td>How to Query a Direct Pay Request FAIINVE</td>
</tr>
<tr>
<td>17- 23</td>
<td>General Journal Voucher FGAVVCD Instructions</td>
</tr>
<tr>
<td>23</td>
<td>How to View a Journal Voucher FGIDOCR Instructions</td>
</tr>
<tr>
<td>24</td>
<td>Single Entry Correction/Transfer Entry Form – Sample</td>
</tr>
<tr>
<td>25</td>
<td>Multiple Entry Correction/Transfer Entry Form – Sample</td>
</tr>
<tr>
<td>26- 35</td>
<td>General Journal Voucher FGAVVCD VISA Instructions</td>
</tr>
</tbody>
</table>
Installing and Modifying Canisius College Templates for Windows 95/98

March 11, 2002

Information Technology Services has provided detailed instructions for “Installing” Canisius College Templates. Please visit the Canisius College Web site and visit the Faculty/Staff Server for detailed instructions.

For Access from your computer simply:

Click on “My Computer”

Click on “Apps on ‘Bagen’ (Please note there are four main Servers, Bagen, Wehle, Loyola, and Amherst. Templates are available on ALL Servers. Use the appropriate Server.)

Dbll Click on the folders ‘Canpub’

Dbll Click on the folder ‘Canisius Templates’

Dbll Click on the folder ‘Templates’

Please note the previous Check Request form, and other obsolete forms must be manually deleted from your individual computers. Should questions arise regarding deletion of forms, please call the Help Desk at Ext. 2299.

The following documents will be available for your use.

FAAINVE Direct Pay Request REV 2 March 2002 (White Only)

FAAINVE Direct Pay Request REV 1 March 2002 Student Activities

REQUEST FOR VENDOR ID NUMBER REV 1 March 2002

PAYROLL FORM REV 1 March 2002 (Do not use for Student Activities, see special form).

PAYROLL FORM Rev 1 March 2002 Student Activities

SINGLE ENTRY BUDGET CORRECTION/TRANSFER ENTRY FORM
MULTIPLE ENTRY BUDGET CORRECTION/TRANSFER ENTRY FORM

CANISIUS COLLEGE VISA CARD AUTHORIZATION FORM REV 1 March 2002
DIRECT PAY REQUEST POLICY AND PROCEDURE

DIRECT PAY REQUESTS: Direct Pay Requests are used if the College Purchasing system of requisitions, VISA card and/or the Diner's Club card cannot be used. Follow specific Canisius College Direct Pay Request Policies and Procedures as noted.


2. Other Reimbursements for food, and supplies, registrations, too numerous to list. Paid receipts must be attached. NOTE: Statements not accepted as an invoice. Enter the Document into Banner and forward to the Controller’s Office for the approval process.

3. Cash Advances: A blank Canisius College Weekly Expense Report will be included with the check. Please return the completed form to the Controllers Office as soon as travel is completed indicating the name the check was made payable to.

4. Direct Pay Requests must be authorized by supervisors and forwarded to the Controllers Office for approval. The Controller’s Office checks for organization and account accuracy. Any honorarium, stipend/speaker fees must include a Vendor ID, complete with NAME, ADDRESS including City, State and Zip Code, and SOCIAL SECURITY NUMBER. Complete a “Request for Vendor ID Number” form and use the Banner generated Vendor ID number when completing FAAINVE.

5. Direct Pay Requests should be typed or computer generated whenever possible. Please provide TWO copies of ALL invoices, or TWO copies of registration forms, etc. that needs to be mailed along with the check. Checks should be mailed from Controller’s Office whenever possible.

6. Please call Claudia Hojnacki (Ext 2840), or Rita Tucker (Ext. 2844) in the Controller’s Office if your are unsure how to go about processing a Direct Pay Request. Check processing ends at 2 p.m. daily, therefore checks will follow three days later. Check processing takes approximately three full business days.

DIRECT PAY REQUEST PROCEDURES,
Rev 1 Page 2 July 2002
MAKE CHECK PAYABLE TO ________________________________

ADDRESS ____________________________________________

CITY ___________________ STATE _____ FED ID OR SSN (Required Social Security Number for Stipends or Honorarium) If required, complete a REQUEST FOR VENDOR ID NUMBER form and return to the Controller's Office

SSN ____________________________ ZIP

CANISIUS COLLEGE FAAINV
DIRECT PAY REQUEST REV 2 MARCH 2002

TRANSACTION DATE ________________________________

PAYMENT DUE

REQUESTOR

COLLEGE PHONE EXT

VENDOR NUMBER

INDEX

ACCOUNT

DESCRIPTION/COMMODITY TEXT

Text Required

TOTAL $ ________________________________

PLEASE INDICATE WITH AN X

☐ US MAIL CHECK

☐ CAMPUS MAIL CHECK

☐ ATTACHMENT TO ACCOMPANY CHECK

☐ PICK UP

PLEASE SEND DIRECT PAY REQUESTS TO
THE CONTROLLER’S OFFICE 3 BUSINESS
DAYS BEFORE CHECKS ARE NEEDED

RECEIPTS ATTACHED

RECEIPTS TO FOLLOW

Special Instructions

CHECK RECEIVED BY

BUDGET SUPERVISORS APPROVAL:

Date

OFFICE USE ONLY: Office of the Controller

CASH ADVANCE NUMBER

Approval By Date

Audited By Date

CHECK NUMBER

DIRECT PAY INVOICE (PEACH) formerly CHECK REQUEST Reimbursements, cash advances
DIRECT PAY INVOICE (LEMON BURST) OTHER PAYMENTS (utilities such as phone, water, electric, gas, cell phone, beepers, others such as water for office use.)
CANISIUS COLLEGE
EMPLOYEE PAYROLL REQUEST Rev 1 March 2002

DATE: ____________________________

REQUEST PAYABLE TO: ____________________________

Name

AMOUNT ____________________________

Reason for Payment ____________________________ Date of Service ____________________________

We are asking for both the Legacy Budget Numbers and the Banner Index regarding all Payroll Requests.

INDEX (Banner) ______________ ORGANIZATION __________ ACCOUNT __________

LEGACY NUMBERS BUDGET __________ LINE __________

ORGANIZATION SUPERVISOR’S APPROVAL __________

COLLEGE PHONE EXTENSION __________

STUDENT ACTIVITIES USE ONLY ORGANIZATION NUMBER __________ ACCOUNT __________

CLUB PRESIDENT or TREASURER __________ DATE __________

FACULTY ADVISOR __________ DATE __________

DIRECTOR OF STUDENT ACTIVITIES __________ DATE

This form to be used to pay Campus Employees and Student Employees who receive a stipend in addition to their hourly rate. This form to be approved by the Organization’s Supervisor and forwarded to the Payroll Office for processing. DO NOT ENTER ANY DATA INTO BANNER. Any questions please call either Denise Rogers at 2847 or Natalie Klyczek at 2841. Student Payroll Requests should be mailed to Denise Rogers, and all other Payroll Requests should be mailed to Natalie Klyczek, Controller’s Office via Campus mail.
REQUEST FOR VENDOR ID NUMBER REV 1 MARCH 2002

Please Print All Information using Upper and Lower Case

VENDOR NAME

ADDRESS

CITY STATE ZIP CODE

VENDOR PHONE NUMBER

VENDOR FAX NUMBER
United States Social Security Number Only
SOCIAL SECURITY NUMBER if required

REQUESTED BY

CAMPUS PHONE NUMBER
RETURN COMPLETED FORM TO RITA TUCKER CONTROLLER’S OFFICE
Only authorized requesters are to access these screens to process Direct Pay Requests. The following page is the first screen that will appear after logging onto Banner. Before starting to process a Direct Pay Request, you should check if a Vendor Number is needed. If paying for Services Rendered to the College and if the Person is not on the payroll the Social Security Number and complete current address is needed, including the zip code. This applies only to U.S. Citizens. If paying a Vendor for Intangible Items purchased by the College we must use the Social Security or Federal ID Number and the complete address is needed including the zip code.

To check if a vendor Number has been assigned, you should type FAAINVE in the Direct Access Field and press Enter.

At this point choose Next Block from the tool bar or press Control Page Down. Tab over to Vendor Name, put in the first four letters of the Vendor’s Name and the percent sign, (i.e. Amer%) or do an Alpha Search, (i.e. A%) and press F8 to execute query.

At this point, arrow down to see what names are in the file.

If the Vendor Name is there, write down the vendor number on your Direct Pay Request, and fill out ALL pertinent information.

At this point you need to confirm the address. Some vendors have multiple address code sequences. You need to confirm the number. Tab by the Seq #: field, if the address is incorrect, the Shift Tab brings you back to the Seq #: change the number from one to two, Tab, this will populate the second address if available. If the address is not there, send a completed Request For Vendor Number form to Rita Tucker in the Controller’s Office with the request to add another address sequence. (Some vendors have up to six addresses.) Please indicate in the right hand margin of your request that this is a new address sequence for that particular vendor.

You are now ready to process your Direct Pay Request.
Tab to **Vendor Name** field and click on the **Flashlight Icon**.

Choose **FTIIDEN**.

Double click on the ID Number field, this will populate your **Invoice/Credit Memo Form** (now refer to page #11) to continue processing your Direct Pay Request.

Click on the **RED DOOR** to exit the screen.

If the name of the vendor is not there, you will have to submit a form to Rita Tucker in the Accounts Payable Office for a Vendor Number to be assigned before paying that Vendor. Please do this as soon as possible to avoid any delays in processing the Direct Pay Request. Users can simply QUERY Banner for the number. “Requests” are entered daily.

Here is "How to Query for Vendor ID Number":

In Banner in the Direct Access field type FAAINVE, and press enter.

Click the search flashlight across from the "Vendor". (Note: Do NOT use the flashlight next to "DOCUMENT".)

From the Option List - Select Entity Name/ID Search (FTIIDEN)

Tab to the Last Name field, put in the first four letter of the the Last Name, and the percent sign, (i.e. Amer%). Press F8 to execute query.

Highlight the Vendor of choice, double click or use the Select Icon, and the Vendor will populate form FAAINVE.

Perform a Next Block or Control Page Down, and the address will populate. Please be sure you check the Sequence for the correct address.
### Entity Name/ID Search Form FTUIDEN 5.0 (PROD)

**Order By ID**
- Vendors
- Grant Personnel
- Financial Managers
- Agencies
- Term Vendors
- Proposal Personnel
- Term Financial Managers
- All

<table>
<thead>
<tr>
<th>ID Number</th>
<th>Last Name</th>
<th>First Name</th>
<th>Mid</th>
<th>E</th>
<th>Ch</th>
<th>V</th>
<th>F</th>
<th>A</th>
<th>G</th>
<th>P</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>20001167</td>
<td>Amer</td>
<td>Shana</td>
<td></td>
<td></td>
<td></td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>20001294</td>
<td>America</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>20001424</td>
<td>American Alarm Services Inc</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20006236</td>
<td>American Alliance for Health, Phys Ed Re</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20012350</td>
<td>American Assoc of Colleges for Teachers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20007121</td>
<td>American Bar Association</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20011833</td>
<td>American Cancer Society</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
PROCESSING A DIRECT PAY REQUEST WITH OR WITHOUT A SOCIAL SECURITY NUMBER

Step # 1

For fast acquisition you can type the desired form ID FAAINVE in the Direct Access field.
The Approvals reminder screen will appear if there are Purchase Orders or Direct Pay Requests to be approved. You can click on the Red Door if you want to do your approvals at another time.
Press Return and the word Next will appear the in the Document space. The system will assign the document number.
Tab to the Vendor Number field and type in the vendor number.
If there is no Vendor Number, tab over once and type in the Vendor Name (This is for a one-time payment not needing a Social Security or Federal ID Number).
At this point choose Next Block from the tool bar or press Control Page Down.
Step #2

If the Vendor Number was chosen from the Vendor list the address, discount code and payment date will automatically populate.

For one-time payments not needing social security numbers you must enter in this information:

- The Invoice Date should correspond to the date on the invoice.
- Transaction Date-the date you want this to hit your budget, however the month must be open.
- Tab to Address and enter the complete address or see page 6.
- Tab to the Discount Code and Enter 05.
- Tab to Payment Date. The computer automatically enters today’s date.
- Tab to the Bank code and Enter 10 (This is for M & T Bank – General Checking).

Skip the Credit Memo field.

Tab over to the Vendor Invoice Number and enter the number (if available) or a brief description of the payment purpose.

**Reminder!** Before processing a check for a 1099 Vendor, a Vendor Number MUST be used.

Vendor Numbers must be requested from the Accounts Payable department using the Request for Vendor ID Number form before processing the Direct Pay Request.

Once all pertinent information is entered, choose Next Block from the tool bar or press Control Page Down.

This will take you to the Commodity Information Window.
Step #3

This is the Commodity Window.

At this point the I Document number appears. This is the number used to track your document.

**Please put it on your Direct Pay Request in the appropriate space.**

Please remember that you may not pay for services rendered (1099) and reimbursements for expenses on the same Direct Pay Requests, however if two I Documents are paid on the same date, they will merge into one check.

Tab over to the Description Field and enter a brief description of the payment.

Then enter amounts in the Approved Amount, and the Additional Amount field can be used for shipping charges or other additional charges; the Net Amount must equal the Invoice Amount.

To enter another item on this request, perform a Next Record function and enter the required information. The keyboard execution for this is the down arrow. This will save the current record and insert a new one. This would be used if paying for more than one item on the Direct Pay Request such as Food & Lodging and Travel.

**Note:** The net totals in the Vendor Invoice Total Amount block continually update as items are added. This displays the total Approved, Discount, Additional, Tax, and Net Amounts for the current vendor invoice, not for the document as a whole.

Once all pertinent information is entered here choose Next Block from the tool bar or press Control Page Down.

This will take you to the Invoice Accounting Distribution Window.
Step #4
This is the Invoice Accounting Distribution Window.
Tab over to the Index Field and enter the Index Code. This will populate all of the fields needed, except for the account number.
Tab over to Account and enter the number, if known.
If the Account Code is not known or you want to check it before you continue, click on the Search Icon.
Press F7 (This is to clear the fields for your specific query).
Tab over to the Account Number.
Enter the first two numbers of the account number and the percentage sign, (i.e. 80%)
Press F8 (This is to execute the query).
Arrow down to the Account Number you want to use, double click on the Title Column; this will populate the account number field.
If you have another account to charge, press the down arrow. This will save the current record and insert a new one.
Repeat the same steps as before, entering Index and Accounting Information,
The Commodity totals are populated from the Commodity Information Window.
Once all pertinent information is entered here, choose Next Block from the tool bar or press Control Page Down.
Step #5

This is the **Balancing and Completion Window**

**Check to make sure you have the I Document Number I _____ _____**

and write it on top of the **Direct Pay Request** in the space provided.

This window displays the summary information. If all appropriate levels are balanced complete the invoice by clicking the **Complete** button.

One of the Organization Approvers must sign the Direct Pay Request Form in the space provided and attach the back-up documents before forwarding to the Controller Office for approval.

**If the Direct Pay Request is not approved,** you may receive a call from the Controllers Office if we cannot correct it. Please read your electronic messages and then remove them, by doing a **Record Remove on the tool bar,** saving your changes and exit the message by using the **RED DOOR.** Banner will ask you if you want to save your changes. Say yes, because you want the messages to be removed.

Once the Direct Pay Request has been completed, they cannot be changed unless they are disapproved. After disapproval, you may go to **FAAINVE,** enter your I Document Number. Choose **Next Block** or **Control Page Down.**

Change the Transaction Date to today’s date. (Note: by using a later date Banner over writes the Transaction information.)

Tab to the payment Due date. Enter today’s date. This date must be equal or later than the Transaction date.

Choose **Next Block** or **Control Page Down.**

This is the **Commodity Information Window.**

Tab thru this form. At the far lower right is the “**Access Completion**” box, **UNCHECK** it!

At this point you can make any correction needed in the Commodity Information Window. Choose **Next Block** or **Control Page Down.**

Make any changes or corrections needed in the Invoice Accounting Distribution window, until you have completed the form. Choose **Next Block** or **Control Page Down.**

Complete the document by clicking on the green complete button.

Send the paperwork back to the Controller’s Office for processing.
HOW TO CANCEL A DIRECT PAY REQUEST

Once the Direct Pay Request has been processed you many need to cancel it.
You must call the Controller’s Office to inform them that you want this Direct Pay Request cancelled. You must have your Document number ready.

HOW TO QUERY DIRECT PAY REQUEST

Once you complete and approve a Direct Pay Request, you cannot query the information from FAAINVE. Instead, you must use the Invoice/Credit Memo Form (FAAINVE). This form can also be used to query A Direct Pay Request that is still in process.
You must enter the document number you want to query in the Document # Field. Select Next Block to access the Invoice/Credit Memo Header Window.
Only authorized personnel can access these screens to process Journal entries into the Finance Ledger.

For fast acquisition to his form type the ID FGAJVCQ in the Direct Access field. These General Entries are for reclassifying entries previously made to correct the Organizations Account balances.

The type of rule class to use is CCRC (Canisius College Reclass Entry). These can only be done within the Organizations that are your responsibility.

Step #1

You must type NEXT in the Document Number field

At this point you must choose NEXT BLOCK from the tool bar or press Control Page Down. The journal number is computer generated.
Step #2
This is the Journal Voucher Document Header Information Window.
The transaction date defaults to the current date. The end of the month date must be used. (i.e. 4/30/02)

NOTE: The VISA Journal Voucher entry uses the first day of the month following the month you are balancing.
Tab to the Document Total field and enter the amount.
This system uses Absolute Totals, which is the total of debits and credits for the entry (i.e. $100.00 Total=$50.00 Debit and $50.00 Credit).
At this point, choose NEXT BLOCK from the tool bar or press Control Page Down.
Step #3

This is the Transaction Detail Window.

For all adjustments use the rule class CCRC in the journal type field.
The sequence number is computer generated.
Tab to the journal type and enter CCRC.
This Window displays the FOAPAL information for the specified journal voucher
document.
Tab over to Index Code.
Enter the Index Code you want to use.
Tab over to Account and enter the number, if known.
If the Account Code is not known or you want to check it before you continue click on
the Search Icon.
Press F7 (This is to clear the fields for your specific query).
Tab over to the Account Number.
Enter the first two numbers of the account number and the percentage sign, (i.e. 80% this
is the to use this for expenses)
Press F8 (This is to execute the query).
Arrow down to the Account Number you want to use, double click on the Title Column:
This will populate the account number field.
Tab to the Amount field and enter the amount for this entry of the transaction.
Debit or Credit must be entered in the next field.
At this point, enter a description for the adjustment (i.e. Charged incorrect account)
NOT the Organizations Name.
Document Number: 00005822

Sequence: 1

Journal Type: CCRC

Chart: C

Index: DEVEL

Fund: 1000

Organization: 6040

Account: 801107

Program: 60

Activity:

Location:

Project:

Percent:

Amount: 50.00

D/C: D

NSF Override

Description: Books

Budget Prd: Pool COA: Fund:

Gift Date:

Number of Units:
Step #4
For the next entry or entries you must specify the data for each of the transaction detail information windows.

However you may copy the previous information by pressing the down arrow, this will save the current record and open up an new one, then press the F4 key (this copies the information from the previous record): then you may adjust the account code.

Enter the amount.
Enter debit or credit.

Type a description of the transaction (i.e. Charged incorrect account).

Press F10 to save the final sequence.

When doing a three or four part journal entry, press the down arrow for the next record, until ALL parts are complete.

Now click on the Transaction Summary under the option menu. This will show if your document totals are in balance with the transaction detail and that the entries are postable.

Once you enter the Transaction Summary information window from the Options Menu you must exist the Red Door one time to return to your document.

Now you may choose Balancing and Completion from the Menu Options or choose NEXT BLOCK from the tool bar or press Control Page Down.

---

Step #4

For the next entry or entries you must specify the data for each of the transaction detail information windows.

However you may copy the previous information by pressing the down arrow, this will save the current record and open up an new one, then press the F4 key (this copies the information from the previous record): then you may adjust the account code.

Enter the amount.
Enter debit or credit.

Type a description of the transaction (i.e. Charged incorrect account).

Press F10 to save the final sequence.

When doing a three or four part journal entry, press the down arrow for the next record, until ALL parts are complete.

Now click on the Transaction Summary under the option menu. This will show if your document totals are in balance with the transaction detail and that the entries are postable.

Once you enter the Transaction Summary information window from the Options Menu you must exist the Red Door one time to return to your document.

Now you may choose Balancing and Completion from the Menu Options or choose NEXT BLOCK from the tool bar or press Control Page Down.
<table>
<thead>
<tr>
<th>Ind</th>
<th>Seq</th>
<th>Type</th>
<th>COA</th>
<th>Index</th>
<th>Fund</th>
<th>Orgn</th>
<th>Acct</th>
<th>Prog</th>
<th>Actv</th>
<th>Locn</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>1</td>
<td>CCRC</td>
<td>C</td>
<td>DEVEL</td>
<td>1000</td>
<td>6040</td>
<td>801107</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>2</td>
<td>CCRC</td>
<td>C</td>
<td>DEVEL</td>
<td>1000</td>
<td>6040</td>
<td>801107</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Amount: 50.00
Debit/Credit: P

Amount: 50.00
Debit/Credit: C

Amount: 100.00

Total: 100.00
Step #5

This is the Completion Window.
Click on the Complete Icon to send this general journal entry to the Controller’s Office for it’s final approval.

To review a Journal Entry you must enter FGIDOCR in the “Direct Access” box. Press Enter.
Enter you Journal entry number, which is the “J” and seven digits, and choose Next Block or Control Page Down.
This will show the debits and credits for that Journal Entry.
When you are finish go out the Red Door once to return to the main menu.
**SINGLE ENTRY**
**BUDGET CORRECTION/TRANSFER FORM**
*Please print or type.*

<table>
<thead>
<tr>
<th>TO:</th>
<th>ELEANOR JASEN</th>
<th>FROM:</th>
<th>DATE:</th>
</tr>
</thead>
<tbody>
<tr>
<td>MONTH:</td>
<td></td>
<td>DATE:</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>INDEX NUMBER</th>
<th>ACCOUNT NUMBER</th>
<th>AMOUNT TO BE DEBITED</th>
<th>EXPLANATION OF BUDGET CORRECTION/TRANSFER</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>INDEX NUMBER</th>
<th>ACCOUNT NUMBER</th>
<th>AMOUNT TO BE CREDITED</th>
<th>EXPLANATION OF BUDGET CORRECTION/TRANSFER</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**ABSOLUTE TOTAL =**
(TOTAL DEBIT + CREDIT)

Office Use Only: Journal Entry Number

Office Use Only: Name of Authorizer / Date

**Note:** A Debit entry charges the budget - increases expenses to an account.
A Credit entry reimburses the budget - decreases expenses to an account.

All corrections or transfers between budgets must be made on this form on a monthly basis. Be sure to fill in all information requested for each transaction and sign the form at the bottom. If there are any questions please call Eleanor Jasen at ext. 2843. The ORIGINAL request must be returned to Eleanor Jasen, Controller's Office - HS-225. Keep a duplicate copy for your files.

Authorized Signature

---

Rev 2 Page 24 July 2002
# Multiple Entry Budget Correction/Transfer Form

**TO:** ELEANOR JASEN  
**FROM:**  
**MONTH:**  
**DATE:**

<table>
<thead>
<tr>
<th>INDEX NUMBER</th>
<th>ACCOUNT NUMBER</th>
<th>AMOUNT TO BE DEBITED</th>
<th>AMOUNT TO BE CREDITED</th>
<th>EXPLANATION OF BUDGET CORRECTION/TRANSFER</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**TOTAL**

**ABSOLUTE TOTAL =**

(TOTAL DEBITS + CREDITS)

Office Use Only: Journal Entry Number

Office Use Only: Name of Authorizer / Date

---

**Note:** A Debit entry charges the budget - increases expenses to an account.  
A Credit entry reimburses the budget - decreases expenses to an account.

*All corrections or transfers between budgets must be made on this form on a monthly basis. Be sure to fill in all information requested for each transaction and sign the form at the bottom. If there are any questions please call Eleanor Jasen at ext. 2843. The ORIGINAL request must be returned to Eleanor Jasen, Controller's Office - HS-225. Keep a duplicate copy for your files.*

Authorized Signature

Rev. 11/01
CANISIUS COLLEGE
GENERAL JOURNAL ENTRIES
FGAJVCD
SELF-BALANCING

CANISIUS COLLEGE VISA PURCHASING CARD

Only authorized personnel can access these screens to process Journal entries into the Finance and Operating Ledger.

Step #1:
For fast acquisition to this form type FGAJVCD in the Direct Access field, hit ENTER.

*These general entries are self-balancing entries for the Canisius College VISA Purchasing Card. Individuals using VISA cards are to submit the Log and Payment Authorization form to the Controller’s Office each month. Persons will enter their purchases using the FGAJVCD form.*

Step #2
In the Document Number field, type NEXT.

Choose NEXT BLOCK from the tool bar or press CTRL PAGE DOWN.

*The rule class we are using is VISA (Canisius College VISA Purchasing Card).
These entries can only be done within the Budgets that are your responsibility.*
Step #3

This is the Journal Voucher Document Header Information Window.
The transaction date defaults to the current date, which is shaded with blue.

Simply type the first day of the month following the month you are balancing. The first day of
the month date must be used. (i.e. Balancing your Feb VISA use 01-Mar-2002).

In the Document Total field enter the TOTAL AMOUNT of your VISA for that particular
month.

This Rule Class uses SELF-BALANCING TOTAL. It is unlike the General Journal
entry, which is the total of debits and credits. We, therefore, only need to enter the exact
amount (DEBIT) of our specific transaction.

Choose NEXT BLOCK or CTRL PAGE DOWN.

Note: Banner has generated your document number, i.e. “J0000070”. Mark the CC
VISA Card Authorization Form with this document number.
Step #4

This is the **Transaction Detail Window**. Tab by the sequence field to the “JOURNAL TYPE”, and enter VISA.

*Note: Banner will enter “1” in the sequence field. This is the first one of several sequences. The total of each sequence amounts will balance your VISA. Banner will populate the field with “Procurement Card Charges”.*

*For all of these transactions use the rule class VISA in the journal type field.*

The **Transaction Detail Window** displays the **FOAPAL** information for the specified journal voucher document.

In the **Index**, enter the alpha and/or number field. (i.e. CONTRL)

*Banner will populate all fields in the FOAPAL except the account (Fund, Organization, and the Program).*

Tab over to the account number and enter the number.

Tab to amount field and enter the amount for this sequence of the transaction.

A “+” must be entered in the DC field.

Tab and enter a **description** for the transaction.

*Type a description of the transaction.*

i.e. *Membership and Dues*

*Contracted Services*

*Printing charges*

*Lodging and Meals*

*Capital Expense Equipment*

*Capital Expense Computers*
<table>
<thead>
<tr>
<th>Ind</th>
<th>Seq</th>
<th>Type</th>
<th>COA</th>
<th>Index</th>
<th>Fund</th>
<th>Orgn</th>
<th>Acct</th>
<th>Prog</th>
<th>Actv</th>
<th>Locn</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>MISA</td>
<td>C</td>
<td>DEVEL</td>
<td>1000</td>
<td>6040</td>
<td>801151</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>CCRC</td>
<td>C</td>
<td>DEVEL</td>
<td>1000</td>
<td>6040</td>
<td>801107</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Amount: 50.00
Debit/Credit: +

Amount: 50.00
Debit/Credit: -

Amount: 100.00
Total: 100.00

Status Indicator: (P)ostable, (E)rror, (N)SF Error.
Step #5

Next, pressing the **DOWN ARROW**, this will give you the **NEXT RECORD** then press the **F4** key (this copies the information from the previous record): then you may adjust the account number or the Index Code if another **ACCOUNT** is to be used.

Enter the amount.

Enter (+) in the DC field.

*When adding a three or four part entry, press the **DOWN ARROW**, for the **NEXT RECORD** and **F4**, change the **ACCOUNT** number. Continue until ALL transactions are complete.*

*When the last sequence for the transaction is entered, **SAVE** or **F10**. Mark the Journal Voucher Number on the Visa Authorization Form.*

**NOTE** Before you Access Completion you may wish to review your document for accuracy. In the Options Menu click on “Access Transaction Summary Info”. A Journal Voucher Summary Form shows the transaction details. Use the **DOWN ARROW** or **ARROW UP**.

**Access Completion** from the Options Menu or choose **NEXT BLOCK** from the tool bar or press **CTRL PAGE DOWN**.

Press **Complete**.

*Click on the **Complete Icon** to send this general journal entry to Claudia Hojnacki for its final approval.*

Note: After you complete this form, it becomes query-only, and you may not make any changes.
**CANISIUS COLLEGE VISA CARD AUTHORIZATION FORM - REV. MARCH 2002**

After completing this form, you must enter data in Banner form FGAJVCD and enter the JV #..............>

Note: 1. Be sure to fill in Index, Fund #, Organization #, Account # and Program #.
2. Verify the GRAND TOTAL matches the TOTAL PURCHASES on your statement.
3. Please print your name and sign the bottom of the form and have your supervisor sign also.
4. Return this form by the 15th of the month to: CLAUDIA HOJNACKI, Controller's Office

<table>
<thead>
<tr>
<th>ITEM</th>
<th>PURCHASE DATE</th>
<th>VENDOR NAME &amp; INFO.</th>
<th>DESCRIPTION / REASON FOR PURCHASE</th>
<th>$ AMOUNT</th>
<th>INDEX</th>
<th>ACCOUNT #</th>
<th>INDEX-ACCOUNT TOTAL AMOUNT *</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Use this column after sorting by Index & Account to sum identical Index-Account strings to make one entry in Banner for that Index & Account.

SUB-TOTAL

GRAND TOTAL

< This is the total for this page only.

< This must match VISA STATEMENT TOTAL.

Cardholder Printed Name ____________________________________  Cardholder Signature ____________________________

Questions re: VISA card, please contact Janine Hughes x 2815. Questions re: Journal Voucher entries, please contact Claudia Hojnacki x2840.

Rev 2  Page 33  July 2002
**CANISIUS COLLEGE VISA CARD AUTHORIZATION FORM - REV. MARCH 2002**

*After completing this form, you must enter data in Banner form FGA/JVCD and enter the JV #.............>

**Note:**
1. Be sure to fill in Index, Fund #, Organization #, Account # and Program #.
2. Verify the GRAND TOTAL matches the TOTAL PURCHASES on your statement.
3. Please print your name and sign the bottom of the form and have your supervisor sign also.
4. Return this form by the 15th of the month to: CLAUDIA HOJNACKI, Controller's Office

<table>
<thead>
<tr>
<th>ITEM</th>
<th>PURCHASE DATE</th>
<th>VENDOR NAME &amp; INFO.</th>
<th>DESCRIPTION / REASON FOR PURCHASE</th>
<th>$ AMOUNT</th>
<th>INDEX</th>
<th>ACCOUNT #</th>
<th>INDEX-ACCOUNT TOTAL AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3/21/02</td>
<td>Home Depot</td>
<td>Repairs</td>
<td>$110.00</td>
<td>TEST 1</td>
<td>801133</td>
<td>$110.00</td>
</tr>
<tr>
<td>2</td>
<td>3/10/02</td>
<td>Eaton Office</td>
<td>Office Supplies</td>
<td>$28.50</td>
<td>TEST 1</td>
<td>801151</td>
<td>$28.50</td>
</tr>
<tr>
<td>3</td>
<td>3/15/02</td>
<td>Eaton Office</td>
<td>Office Supplies</td>
<td>$50.28</td>
<td>TEST 1</td>
<td>801151</td>
<td>$50.28</td>
</tr>
<tr>
<td>4</td>
<td>3/29/02</td>
<td>Eaton Office</td>
<td>Office Supplies</td>
<td>$10.00</td>
<td>TEST 1</td>
<td>801151</td>
<td>$10.00</td>
</tr>
<tr>
<td>5</td>
<td>3/18/02</td>
<td>Quality Bindery</td>
<td>Printing Charges</td>
<td>$75.00</td>
<td>TEST 1</td>
<td>801251</td>
<td>$75.00</td>
</tr>
<tr>
<td>6</td>
<td>3/1/02</td>
<td>Eaton Office</td>
<td>Office Supplies</td>
<td>$100.00</td>
<td>TEST 2</td>
<td>801151</td>
<td>$100.00</td>
</tr>
<tr>
<td>7</td>
<td>3/30/02</td>
<td>AJCU</td>
<td>Subscription</td>
<td>$150.00</td>
<td>TEST 2</td>
<td>801173</td>
<td>$150.00</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SUB-TOTAL</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>$523.78</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>GRAND TOTAL</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>$523.78</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Use this column after sorting by Index & Account to sum identical Index-Account strings to make one entry in Banner for that Index & Account.

Jane Doe
Cardholder Printed Name

Cardholder Signature

04/01/2002
Date

Supervisor's Signature

**Questions re:** VISA card, please contact Janine Hughes x 2815. Questions re: Journal Voucher entries, please contact Claudia Hojnicki x2840.
**SCT Banner - PROD**

**Transaction Detail**  FGAJVCD 5.1.0.1 (PROD)

<table>
<thead>
<tr>
<th>Document Number: 10005822</th>
<th>Submission: 0</th>
<th>Document Total: 50.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status:</td>
<td>Sequence: 1</td>
<td>Journal Type: VISA Procurement Card Charges</td>
</tr>
<tr>
<td>COA: DEVEL</td>
<td>Fund: 1000</td>
<td>Orgn: 6040</td>
</tr>
<tr>
<td>Percent:</td>
<td>Amount: 50.00</td>
<td>DC:</td>
</tr>
<tr>
<td>Description: Office Supplies</td>
<td>Bank: Deposit:</td>
<td>Cmt:</td>
</tr>
<tr>
<td>Encumbrance #: Item: Seq: Action: (None)</td>
<td>Complete: In Process:</td>
<td></td>
</tr>
</tbody>
</table>

Select to keep Document Incomplete and "In Process"

Record: 171

Start Microsoft Word - claudia's SCT Banner - PROD

Rev 2 Page 35 July 2002
CANISIUS COLLEGE

FINANCE RELEASE 4

PURCHASING TRAINING MATERIALS
REV 1

PURCHASING OFFICE

SPRING 2002
Canisius College Purchasing Department

Commonly Used Purchasing Forms

FPAREQN - How to Create a Requisition
FOAUAPP - User Approval Form
FPARCVD - Receiving Goods Form
FPARDEL - Requisition cancel form
FOIDOCH - Document History Form
FGIBDSR - Organization Budget Status Form
FPIREQN - Copy a requisition
FOIAINP - Approvals Notification form
GUAMESG - General Message Form
FPIREQST - Requisition Validation Form
How to Create a Requisition

Sign on to Banner.

Type in FPAREQN in Direct Access – enter.

This will automatically bring up the Requisition Form. The Requisition Form initiates the procurement process by defining an internal request to acquire goods or services.

In the requisition field, enter the word NEXT. This will allow the system to generate a requisition number.

At this point choose Next Block from the tool bar or use the keyboard execution Control/Page Down

Starting from this point you will see a SEARCH BUTTON (Light) on different fields. Click on the Light it will bring up information pertaining to the field. Choose what is applicable in that field.
Requestor / Delivery Information window

This window provides information regarding the requester and where the items are to be delivered.

The fields in this window include Order Date, Transaction Date and Delivery date. The delivery date must be filled in. If date occurs in same month just enter the day and tab, the month and year will fill in automatically.

The 30 character Comments field allows you to enter delivery information, which carries from document to document.

**Navigate by Tabbing to each of these fields.**

The Requester field will be automatically displayed. The COA, Organization, Email, Phone and Fax fields can be manually entered if it has not been automatically populated.

**Navigate by Tabbing to each of these fields.**

Ship To is a required field. Click on the search button and select the appropriate ship to. The attention field can be used to change the contact information or add additional information. This information is only stored for this order.

**Next Block or Control / Page Down**
Vendor Information window

In the Vendor field click on the search button, select the Entity Name / ID Search Form. Go to “Options” on the left-hand side of window and click on “search”, all Vendors in the system will appear.

A faster way to find a vendor is to do a query. While in the Entity Name/ID Search Form,

Enter query – F7 key – or the Enter Query button

Click on area labeled “last name”

Enter name of vendor, or, the first letter, or letters of the vendor name followed by the % sign.

Execute query – F8 key – or the Enter Query button

The system will bring up all vendors’ names beginning with the letter queried

Double click on vendor number to be selected; Banner will automatically populate vendor area.

If a particular vendor is not located in the database a Request for Vendor Form must be filled out and sent to Accounts Payable. See page 5 of the Direct Pay Manual for Sample.

At this time you may exit the requisition form.

Make sure to copy down the requisition number that has been assigned at top of the page. The requisition number is needed to be able to enter this requisition again by going to FPAREQN and typing the requisition number instead of NEXT.
To send a message to Purchasing Department, click on Document Text under “Options.” This will bring up the Document Text Entry Form – FOAPOXT.

Click on first text line and type your note to purchasing. Use the down arrow if additional space is required. For examples: “Please Fax,” “Please call in order,” “Enclose check,” or any other type of instructions for the purchasing staff.

Save by using F10 or the Yellow Save Button.

Exit.

Next Block or Control / Page Down.
Commodity / Accounting fpAreQn

Tab over the Comm field.

In the first line of the Description field type in a complete description of the item to be ordered. Space for 50 characters available. For example, if buying furniture: On first line - Steelcase pedestal desk / Quote 12345 dated 02/26/02. If additional typing space is required, follow the next steps. If no additional space is needed tab to the next field “U/M” and follow directions on page 7.

Click on Item Text under “Options” and another block will appear.

Click in text area and begin typing.

Arrow down to next line if more space is required.

When complete, save by Clicking on Yellow Save Button or F10. EXIT

REV 1 Page 7 03/11/2002
Commodity / Accounting FPAREQN

**Tab** to the U/M Field. Type in unit of measure or **Click on Search Button** – select the appropriate unit of measure.

**Click on selection.**

Type in Quantity - **Tab**
Type in Unit Price – **Tab**
Type in Discount – **Tab**. DO NOT USE
Type in Additional – **Tab**. DO NOT USE

Please note **important** items on page 9.

The cursor is now back to the **Comm Field**. Arrow down and repeat the directions on pages 6 & 7 until all of the products or services are entered for requisition. When complete:

**Next Block or Control / Page Down**

<table>
<thead>
<tr>
<th>Item</th>
<th>U/M</th>
<th>Tax Grp</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Ex Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EA</td>
<td></td>
<td>1</td>
<td>300</td>
<td>300.00</td>
</tr>
</tbody>
</table>

**Comm**

Steelcase pedestal desk/quote 12345/0

**Desc**

**Comm Text**

☐ Item Text

☐ Add Commodity

☐ Distribute

Comm Line Total: 300.00

Doc Comm Total: 0.00

<table>
<thead>
<tr>
<th>FOAPAL</th>
<th>%</th>
<th>USD</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Yr</th>
<th>Index</th>
<th>Fund</th>
<th>Orgn</th>
<th>Acct</th>
<th>Prog</th>
</tr>
</thead>
</table>

REV 1 Page 8 03/11/2002
IMPORTANT

Discounts – Discounts, both dollars and %, are subtracted from the individual items. Do not use the Disc. Field in the requisition. Describe the discount as part of the item text. See example. If you are unsure of how to enter a discount, call the Purchasing Office for assistance.

Additional Charges – Enter additional charges such as shipping, handling or miscellaneous charges as a separate line item on the Requisition. Do not enter these charges in the Addtl field. See example. If you are unsure of how to enter a discount, call the Purchasing Office for assistance.

Zero and Negative Amounts – All items on a Requisition must have a positive dollar amount. Zero or negative dollar amounts cannot be entered in Banner.
### Requisition Entry: Commodity/Accounting

**Requisition:** R0001470  
**Order Date:** 28-FEB-2002  
**Delivery Date:** 01-MAR-2002  
**Trans Date:** 28-FEB-2002

<table>
<thead>
<tr>
<th>Item</th>
<th>U/M</th>
<th>Tax Grp</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Ext Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EA</td>
<td></td>
<td>1 x 25</td>
<td>25.00</td>
<td>25.00</td>
</tr>
</tbody>
</table>

**Comm Desc:** Steelcase pedestal desk/quote 12345/D  
**Comm Text:** shipping and handling or delivery  
**Add Commodity:**  
**Distribute:**

**Comm Line Total:** 25.00  
**Doc Comm Total:** 300.00

---

**FOAPAL**

<table>
<thead>
<tr>
<th>Remaining Comm Amt: 300.00</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Yr</th>
<th>Index</th>
<th>Fund</th>
<th>Orgn</th>
<th>Acct</th>
<th>Prog</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

### Requisition Entry: Commodity/Accounting

**Requisition:** R0001470  
**Order Date:** 28-FEB-2002  
**Delivery Date:** 01-MAR-2002  
**Trans Date:** 28-FEB-2002

<table>
<thead>
<tr>
<th>Item</th>
<th>U/M</th>
<th>Tax Grp</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Ext Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>EA</td>
<td></td>
<td>1 x 350</td>
<td>350.00</td>
<td>350.00</td>
</tr>
</tbody>
</table>

**Comm Desc:** Steelcase pedestal desk/quote 12345/D  
**Comm Text:** shipping and handling or delivery  
**Add Commodity:**  
**Distribute:**

**Comm Line Total:** 350.00  
**Doc Comm Total:** 325.00

**FOAPAL**

<table>
<thead>
<tr>
<th>Remaining Comm Amt: 0.00</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Yr</th>
<th>Index</th>
<th>Fund</th>
<th>Orgn</th>
<th>Acct</th>
<th>Prog</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>02.</td>
<td>PURCH</td>
<td>1000</td>
<td>6030</td>
<td>81200</td>
</tr>
</tbody>
</table>

---

**Document Accounting Total:** 325.00
Commodity / Accounting FOAPAL

This block sets up what organizations (budgets) are to be charged.

C - Tab over this field.

Index Field – Click on search button and select index code for your organization (department).

Acct Field – Click on search button and select code.

The Fund, Organization, and Prog Fields will automatically fill in.

Tab through remaining fields.

Click on Ext Field – Enter amount to be paid on this budget.

Disc – Tab. DO NOT USE
Addtl – Tab. DO NOT USE

Tab.

To add an additional budget, Arrow down and follow the above directions.

If a mistake is made, click on record and select remove. This will clear the area of all information on the line the cursor is on.

Before doing next block and completing the requisition, go back over the requisition and check that everything is entered correctly. A requisition can be cancelled at anytime during the process by doing previous block to the first screen of the requisition and double clicking on delete record. Once completed a requisition can only be canceled by going to the Requisition Cancel Form FPARDEL. Click on Balance / Completion under “Options” side of screen.
<table>
<thead>
<tr>
<th>Item</th>
<th>U/M</th>
<th>Tax Grp</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Ext Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>EA</td>
<td></td>
<td>1</td>
<td>25</td>
<td>25.00</td>
</tr>
<tr>
<td>Comm</td>
<td>Desc</td>
<td>Comm Text</td>
<td>Item Text</td>
<td>Add Commodity</td>
<td>Distribute</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steelcase pedestal desk/quote 12345/D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>shipping and handling or delivery</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**FOAPAL**

- Remaining Comm Amt: 325.00
- Ext: 325.00 USD
- Disc: 0.00
- Addtl: 0.00
- Tax: 0.00
- NSF: 0.00
- Override: 0.00
- Suspense: 0.00
- FOAPAL Line Total: 325.00
- Document Acctg Total: 0.00
Click on Complete.

Requisition is complete. Write down your requisition number located at bottom left hand corner of screen for your records. You now have the ability to enter another requisition or exit.
User Approval Form  FOAUAPP

Use this form to approve (or disapprove) completed requisitions generated within your organization. Once a requisition has been completed, it cannot be corrected or changed unless it is disapproved.

Type in FOAUAPP in Direct Access

Enter

Click on approve checkmark area or Next Block / Control Page down – all completed requisitions will appear.

Click on detail – all organization information will appear.

Click on Document Query and the requisition number will appear. Here you are able to view the entire requisition by clicking on next block to view each screen.

Click exit twice when completed to bring the cursor back to User Approval Form.

Click on approve or disapprove

Click on OK

If requisitions have been approved, these have been sent to the purchasing department for final approval or disapproval.

If requisitions have been disapproved, go back to FPAREQN enter the requisition number and make all corrections. Corrections can only be made on requisitions that have been disapproved or are incomplete.
<table>
<thead>
<tr>
<th>Document</th>
<th>Chg</th>
<th>Sub</th>
<th>Originating User</th>
<th>Document</th>
<th>Queue</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSF Type</td>
<td>Number</td>
<td>No.</td>
<td>No.</td>
<td></td>
<td>Amount</td>
<td>Type</td>
</tr>
<tr>
<td></td>
<td>INV</td>
<td>0007566</td>
<td>0</td>
<td>NAPLES</td>
<td>40.00</td>
<td>DOC</td>
</tr>
<tr>
<td>Approve:</td>
<td>✓</td>
<td>Disapprove:</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>INV</td>
<td>0014115</td>
<td>0</td>
<td>TUCKERL</td>
<td>140.25</td>
<td>DOC</td>
</tr>
<tr>
<td>Approve:</td>
<td>✓</td>
<td>Disapprove:</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>INV</td>
<td>0014960</td>
<td>0</td>
<td>KANIECKE</td>
<td>1359.00</td>
<td>DOC</td>
</tr>
<tr>
<td>Approve:</td>
<td>✓</td>
<td>Disapprove:</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>INV</td>
<td>0015182</td>
<td>0</td>
<td>KANIECKE</td>
<td>624.75</td>
<td>DOC</td>
</tr>
<tr>
<td>Approve:</td>
<td>✓</td>
<td>Disapprove:</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Receiving Goods Form  FPARCVD

Receive all Items

Receiving transactions may only be performed against approved purchase orders.

Type in FPARCVD in Direct Access.
Enter

Type in Next

**Next Block or Control / Page down.**

It is not necessary to fill in receiving header –**Next Block or Control / Page Down.**
Fill in packing slip number or 99999 if no packing slip number exists. –**Next Block or Control / Page Down.**

Click on receive item circle, if it is blank.

Fill in purchase order number - **Tab** - remaining area will fill in.

Under “Options” side of window:

Click on **Receive All** if all items are to be received.

Enter

**Next Block or Control / Page down**

If all items are received, The “Final Received Box” will have a check mark and the quantity field will be filled in. Arrow down or move slide bar to check each item if more than one.

**Next Block / Control Page Down.**

Click on **Complete.**
**Receiving Header**

**Carrier:**

**Date Received:** 05-MAR-2002

**Received By:** HUGHESJ

**Packing Slip**

**Packing Slip:** 99999

**Bill of Lading:**

**Purchase Order**

**Purchase Order:** PO001557

**Receive Items:** ✔

**Adjust Items:**

**Buyer:** Gary B Lew

**Vendor:** 20000189 Delaware Av Distributors Inc

---

**Commodity Record Count:** 1

**Item:** TV Monitor 27" JVC

**Stock Item:** ✔

**U/M:** EA

**FOB:**

**Final Received:** ✔

**Quantity**

- **Received:** 1
- **Rejected:** 0
- **Returned:** 0
- **Accepted:** 1
- **Ordered:** 1

**To Date**

- **Current**

**U/M:** EACH

---

**Completion**

**Item Suspense:**

**Tolerance Suspense:**

**Tolerance Override:**

---

**Complete:**

**In Process:**

---

REV 1  Page 17  03/11/2002
Receiving Goods Form  FPARCVD

Select Items to be Received

Type in  FPARCVD in Direct Access

Enter

Type in Next

Next Block/Page Down.

It is not necessary to fill in receiving header – Next Block or Control/Page Down
Fill in Packing slip number or 99999 if no packing slip number exists. Next Block or Control/Page Down.

Click on receive item circle, if it is blank.

Fill in purchase order number – Tab – remaining area will fill in.

Under “Options” side of window:

Click on Select Purchase Order Items.

Next Block / Control Page Down

Click on Add Items on right hand side of window next to each commodity to be received.

Save – F10

Click on OK

Exit.

Next Block / Control Page Down

Tab to Quantity Received; enter quantity you are receiving. Click on Final rec. if all items are in for this line. If all items are not in do not check this box.

Arrow Down or Move slide bar until item #2 appears in Item Field.
Tab to Quantity Received and enter quantity to be received. Click on Final rec. if all items are in for this line. If all items are not in do not check this box.
Continue these steps until all commodities are completed.

Click on Access Completion on left option side of the window.

Click on Complete.
### Item 1

<table>
<thead>
<tr>
<th>Code</th>
<th>Commodity Description</th>
<th>Stock Item?</th>
<th>U/M</th>
<th>FOB</th>
<th>Final Received?</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>9x12 env. Education Dept.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>✔</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quantity</th>
<th>To Date</th>
<th>Current</th>
<th>U/M:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Received:</td>
<td>0</td>
<td>0</td>
<td>N/A</td>
</tr>
<tr>
<td>Rejected:</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Returned:</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accepted:</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ordered:</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Item Suspense:** ❌
- **Tolerance Suspense:** ❌
- **Tolerance Override:** ❌

### Item 2

<table>
<thead>
<tr>
<th>Code</th>
<th>Commodity Description</th>
<th>Stock Item?</th>
<th>U/M</th>
<th>FOB</th>
<th>Final Received?</th>
</tr>
</thead>
<tbody>
<tr>
<td>#2001676 11x17 20# white</td>
<td></td>
<td>N/A</td>
<td>CTN</td>
<td>N/A</td>
<td>✔</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quantity</th>
<th>To Date</th>
<th>Current</th>
<th>U/M:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Received:</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Rejected:</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Returned:</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accepted:</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ordered:</td>
<td>2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Item Suspense:** ❌
- **Tolerance Suspense:** ❌
- **Tolerance Override:** ❌
Requisition cancel form - FPARDEL

Before a requisition can be canceled, it must be completed and approved. In the Request Code Field, enter the requisition number to be canceled.

Next Block OR Control / Page Down.

Click on Access Cancel Date on left option side of the window.

The cursor is now in the Cancel Date Field, which displays the current date. The date must be after the original transaction date. Enter another date if needed.

Double click on Reason Code Field.

Click on reason and it will populate Reason Code Field.

Click on Process Cancellation on left option side of window
Requisition is now canceled.

Exit.
Organization Budget Status Form – FGIBDSR

Type in FGIBDSR – Enter.

Fill in Fiscal Year - Tab

Fill in Index Field - Tab.

Select Commit Ind – Next Block / Control Page Down.

On left option side of screen, click on any of the selections to view department budget.

Exit when finished.
Document History Form – FOIDOCH

Type in FOIDOCH – enter.

Double click on Doc Type – select Type.

Type in Doc Code or use Search Button and Double click on selection.

Next Block / Control Page Down.

This will populate all fields pertaining to selected document.

Click on any of the fields. For example, if the purchase order field is selected, additional options will appear on left option side of the window. Click on purchase order information and purchase order will appear. Next Block / Control Page Down through the entire purchase order. This is the same for the remaining fields. Exit when finished.
How to Copy a Requisition  FPAREQN

Type in FPAREQN.

Enter

Click on copy a requisition on left option side of window. Box comes up.

Click on Search Button or type in requisition number to be copied.

Double click on requisition to be copied. This will populate field.

Click on OK.

The requisition to be copied will appear. All changes can now be made where necessary. The Vendor can never be changed. A new requisition has to be created in this case. Complete and approve.

![Image of Requisition Form](image-url)
General Message Form - GUAMESG

This form will appear whenever a user logs on to Banner or when accessing the Approval Form – FOAUAPP. A reason for Disapproval will be listed. To remove the message double click on record remove.

F10 Save

Exit
**Approvals Notification form – FOIAINP**

After Logging on to Banner, the Approvals Notification Form will appear. This is to inform the user that requisitions require approval.

<table>
<thead>
<tr>
<th>Number of Documents</th>
<th>Document Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Requisition</td>
<td>Awaiting your review</td>
</tr>
<tr>
<td>11</td>
<td>Invoice</td>
<td>Awaiting your review</td>
</tr>
</tbody>
</table>
Requisition Validation Form – FPIRQST

Type in FPIRQST.

Select requisition you want. On left option side of window are two choices: View Commodities or Requisition Information.

View Commodities will bring up FOICOMM. All Commodities for this requisition will be listed. Click on View Accounting Information – This will bring up form FOICACT and will show all accounting information.

Click on Requisition Information and bring up Form FPIREQN. Click on Next Block to view the completed requisition.

Exit at any point of this form.